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1. Introducción 

¿Qué es la fotogrametría? 

La fotogrametría es la técnica cuyo objeto es estudiar y definir con precisión la forma, 

dimensiones y posición en el espacio de un objeto cualquiera, utilizando esencialmente 

medidas hechas sobre una o varias fotografías de ese objeto. 

¿Qué es y para qué sirve Agisoft Metashape? 

Agisoft Metashape es un producto de software independiente que realiza el procesamiento 

fotogramétrico de imágenes digitales y genera datos espaciales 3D para su uso en 

aplicaciones SIG, documentación del patrimonio cultural y producción de efectos visuales, 

así como para mediciones indirectas de objetos de varias escalas. 

 

2. Requisitos del sistema. 

Configuración mínima: 

• Windows XP o posterior (32 o 64 bits), Mac OS X Mountain Lion o posterior, 

Debian / Ubuntu con GLIBC 2.13+ (64 bit) 

• Intel Core 2 Duo o equivalente 

• 4 GB de RAM 

Configuración recomendada: 

• Windows 7 SP 1 o posterior (64 bits), Mac OS X Mountain Lion o posterior, 

Debian / Ubuntu con GLIBC 2.13+ (64 bits) 

• Intel Core i7 o AMD procesador 7 Ryzen 

• Discreta de NVIDIA o AMD GPU 

• 32 GB de RAM 

El número de fotos que puede ser procesado por Metashape depende de los parámetros de 

RAM y reconstrucción disponibles utilizados. Suponiendo que una única resolución de la 

foto es del orden de 10 MPIX, 4 GB de RAM es suficiente para hacer un modelo basado en 

30 a 50 fotos. 16 GB de RAM permitirá a procesar hasta 300-400 fotografías. 
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3. Instalación 

Mediante un navegador accedemos a la página oficial de Agisoft, ​https://www.agisoft.com​.  

 

 

 

Procederemos a descargar el software desde su página de descargas eligiendo el sistema 

operativo en el que se instalará. 
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Se abrirá una ventana pidiendo que indiquemos el lugar donde se guardará el archivo 

comprimido. 

 

 

 

Extraemos el archivo. 
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Entramos dentro de la carpeta obtenida, hacemos click-derecho para abrir una terminal con 

la ruta de la carpeta. 

 

 

 

Ejecutamos el archivo metashape.sh con el comando de la imagen: 
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Aparecerá la interfaz de Metashape pidiendo el código de activación, se puede usar durante 

un mes gratuitamente. 

 

 

 

4. Configuración. 

En la pestaña ​Tools ​del menú de opciones, elegimos ​Preferences​. 
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Se nos mostrará una ventana con varias pestañas, en la pestaña ​General​ podemos modificar 

el idioma, el tema de la interfaz, etc… 

 

 

 

La pestaña ​GPU​, debemos marcar si nuestro equipo dispone de tarjeta gráfica, no es 

necesario, pero acelerará el proceso si se tiene. 
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5. Procedimiento para la obtención del modelo 3D. 

5.1. Crear bloques. 

Crearemos un bloque por cada grupo de fotos realizadas desde diferente ángulo y 

altura. En este caso 2 bloques. 
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5.1.1. Añadir fotografías. 

Añadimos las fotografías a cada bloque dirigiéndonos al menú de opciones 

en ​Flujo de trabajo->Añadir fotos… 
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Se abrirá una ventana modal en la cual se nos permite buscar en nuestro 

equipo el lugar dónde están las imágenes que queremos cargar y 

seleccionarlas. 

 

 

 

Vemos cómo se añaden a el bloque 1, desplegando podemos ver un nuevo 

apartado llamado ​Cámaras​ que contiene las fotografías. 
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Hacemos lo mismo con el segundo bloque. 
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MANUAL AGISOFT METASHAPE y escalado del modelo 3D con Meshlab  



13 

 

 

5.2. Orientar fotografías y crear puntos de paso. 

Una vez que las fotos se cargan en Metashape, tienen que estar alineadas. En esta 

etapa Metashape encuentra la posición de la cámara y la orientación de 

cada fotografía y construye un modelo de nube de puntos de paso. 

Para ello nos dirigimos al menú de opciones ​Flujo de trabajo->Orientar fotos… 
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Se nos puede dar el caso de que algunas fotos no se hayan podido orientar, para 

solucionar esto, seleccionaremos las fotografías no orientadas (​NA​) y repetiremos 

el proceso de orientación. 
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5.2.1. Crear máscaras. 

Como podemos ver, los puntos de paso están muy dispersos, eso quiere 

decir que nuestro objeto no se está distinguiendo del fondo, crearemos 

máscaras en las fotografías para que el programa lo pueda definir. 

Metashape adjunta herramientas para llevar a cabo esta tarea. 
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En la barra de herramientas, en el botón de selección, escogemos las ​Tijeras 

inteligentes. 

 

 

 

Marcamos un punto en el borde del objeto y pulsamos la tecla ​ctrl​, según 

avanzamos con el cursor del ratón sobre el borde, vemos cómo se va 

ajustando a éste, cada cierto tramo hay que hacer un click y bordear todo el 

objeto hasta que la selección esté completa. 
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Una vez seleccionado todo el contorno nos dirigimos al menú de opciones 

Edición->Invertir selección. 

 

 

 

Regresamos a ​Edición->Añadir selección​ y ya tendremos una máscara 

creada. Unas 10 máscaras por bloque son suficientes para la cantidad de 

fotos que tenemos en este ejemplo, algunas veces son más, otras menos y 

en algunos casos no son necesarias, todo depende de lo dispersos que 

estén los puntos de paso.  
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Para visualizar las máscaras que tenemos podemos pulsar en el botón que 

se indica en la imagen siguiente ‘​Mostrar máscaras​’. 

 

 

 

 

 

 

 

MANUAL AGISOFT METASHAPE y escalado del modelo 3D con Meshlab  



22 

Una vez creadas las máscaras deberemos volver a ​Flujo de trabajo->Orientar 

fotos… 

 

 

 

En la ventana modal indicaremos ​Aplicar máscaras a: Puntos de paso y                       

aceptamos. 
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Y ahora ya podemos visualizar los puntos de paso del objeto correctamente 

separados del fondo. 
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Repetimos los pasos anteriores con el otro bloque. 
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MANUAL AGISOFT METASHAPE y escalado del modelo 3D con Meshlab  



26 
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5.3. Nube de puntos densa. 

Metashape permite generar y visualizar un modelo de nube de puntos densa. Con 

base en las posiciones estimadas de la cámara el programa calcula la información 

de profundidad para cada cámara que se combinan en un solo punto de 

enturbiamiento denso. 

Flujo de trabajo->Crear nube de puntos densa… 
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Repetimos el proceso con el otro bloque. 
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5.3.1. Limpieza de la escena. 

Como podemos observar, alrededor del objeto hay partes que no pertenecen 

a éste, procederemos a limpiar lo máximo que podamos la escena ya que no 

queremos que esas partes se procesen y pasen a pertenecer al modelo 3D. 

Usaremos la herramienta de ​Selección de forma libre​. 

 

 

 

Marcaremos los sobrantes teniendo cuidado en no seleccionar el modelo 

ayudándonos con el zoom, la rotación y la traslación del objeto. 
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Una vez seleccionado nos dirigimos a ​Edición->Borrar selección​ y 

continuaremos hasta que en la escena sólo esté el objeto. 
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Repetimos con el otro bloque. 
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5.4. Orientar bloques. 

El siguiente paso es orientar los bloques antes de fusionarlos. 
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Al igual que en las anteriores orientaciones, en la ventana modal indicaremos 

Aplicar máscaras a: Puntos de paso ​y aceptamos. 
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5.5. Fusionar bloques. 

Una vez orientados los bloques procedemos a fusionarlos para obtener un único 

bloque del que obtendremos la malla del modelo 3D. 

Flujo de trabajo->Fusionar bloques… 
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En la ventana que se nos muestra debemos señalar o desmarcar, en el caso que 

haya más de dos bloques, los que nos interesen (no tienen porqué ser todos los 

que hay) y obtendremos el bloque ​Merged Chunk​ con el que trabajaremos a partir 

de ahora. 
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5.6. Crear malla. 

Basándose en la información de la nube de puntos densa. Metashape puede 

reconstruir un modelo poligonal - malla. 

Flujo de trabajo->Crear malla… 
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5.7. Crear textura. 

Para finalizar, una vez obtenida la malla crearemos la textura. 

Flujo de trabajo->Crear textura… 
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Obtención del modelo 3D. 
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5.8. Exportar modelo. 

Exportamos el modelo en el formato que nos interese eligiendo una opción de las 

que nos ofrece Metashape, también podremos elegir el formato de la textura entre 

otras opciones. 
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6. Escalar modelo 3D con Meshlab. 

6.1. Instalación de Meshlab. 

Meshlab es un software que se ocupa de las mallas triangulares de un diseño 3D. 

Proporciona un conjunto de herramientas para editar, limpiar, reparar, inspeccionar, 

renderizar, dar textura y convertir mallas, es Open Source y se encuentra en los 

repositorios de Ubuntu. Abrimos el ​centro de software​ e iniciamos una búsqueda 

del programa. 
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Elegimos la versión estable e instalamos. 
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Una vez realizada la instalación, iniciamos el programa. 
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6.2. Importar mesh. 

Seleccionamos ​File->Import Mesh, en la ventana modal seleccionamos el modelo 

que vamos a importar a Meshlab. 
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6.3. Transformar escala. 

En primer lugar usamos la herramienta de medición , situada en la barra de 

opciones superior, medimos con ella la referencia que colocamos en el objeto, nos 

dará un número que usaremos para calcular el factor de escala. 
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La referencia en el objeto tiene una longitud real de 20 mm. que dividiremos por el 

número obtenido anteriormente, redondeamos el resultado para quedarnos sólo 

con la parte entera del número. 

 

 

 

Seleccionamos ​Filters->Normals, Curvatures and Orientation->Transform: Scale​. 
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Se muestra una ventana modal donde usaremos el factor de escala obtenido 

anteriormente aplicándolo en los tres ejes, X, Y, Z. Meshlab por defecto no nos deja 

añadir directamente valores mayores a 10, para poder hacerlo debemos añadir un 

100 y el número que usaremos, en este caso nos quedaría 100154, para 

posteriormente eliminarlo y quedar únicamente el 154. 
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Pulsamos el botón ​Preview​ antes de aplicar los cambios (si el modelo desaparece, 

usando la combinación de teclas ​ctrl + h​ se vuelve a visualizar) y comprobamos 

usando la herramienta de medición, el resultado tiene que ser los mismos 

milímetros que la referencia usada. 
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Si la comprobación es correcta podemos aplicar los cambios dando lugar al 

modelo 3D escalado. 

 

 

 

6.4. Exportar modelo 3D. 

Seleccionamos ​File->Export Mesh As​.  
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En la ventana que se nos muestra podremos elegir el tipo de archivo en el que 

queremos exportar el modelo, nombre y lugar donde deseamos guardarlo. 
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Nos ofrece una serie de opciones que podemos modificar según necesitemos, y el 

nombre del archivo de textura asociado al modelo, si se desea se podría renombrar.  
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